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Abstract
● AIM: To compare the exposure rate, infection rate, 
percentage of enhancement, and success rate between 
Medpor and the three-dimensional printed polyethylene 
(3DP-PE) orbital implant in a preliminary report.
● METHODS: This prospective, randomized, equivalence, 
controlled trial was conducted at two institutes. The 
equivalent margin was ±10%. The sample size for the 
equivalence trial was 174 participants per group. Patients 
who were eligible for enucleations received either Medpor 
or 3DP-PE implants based on a randomized block of six. 
The surgeries were performed by five oculoplastic surgeons. 
The assessor and patients were masked. The magnetic 
resonance imaging (MRI) of the orbit was performed at least 
6mo after operation and the fibrovascular ingrowth was 
analyzed using the Image J software. Follow-up continued at 
least 1y after surgery. The intention to treat and per protocol 
approaches were used.
● RESULTS: Totally 128 patients met the criteria in the 
report. Fifty Medpor and 55 3DP-PE cases completed the 
trial. The most common cause of blindness was trauma. 

The mean follow-up times of Medpor and 3DP-PE were 
33 and 40mo respectively. The exposure rate was not 
statistically significant between two groups (6.0% and 
7.3%), P<0.05, 95%CI (-9.8%, +12.0%). The success rates 
were 94% (Medpor) and 92.7% (3DP-PE). No postoperative 
infection was reported. Nine patients had MRI tests and 
two had implant exposures with 66.3% enhancement at 
75mo (Medpor) and 58% enhancement at 57mo (3DP-PE) 
postoperatively.
● CONCLUSION: There is no statistically significant 
difference in exposure rate and success rate between 
Medpor and 3DP-PE in enucleation in the report. However, 
we cannot conclude that they are equivalent in terms of 
the exposure rate and success rate because the 95%CI is 
wider than ±10%. The infection rate is equivalent in both 
groups.
● KEYWORDS: orbital implants; eyeball enucleation; 
polyethylene; blindness; eye injuries; orbit
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INTRODUCTION

P orous polyethylene orbital implant is a standard 
treatment for eye removal surgery. The main advantage 

of a porous implant over a non-porous implant is to promote 
vascularization, improve motility and decrease migration and 
extrusion[1]. Porous polyethylene orbital implant has been 
claimed to be superior to other porous implants in terms of 
capability to suture to the implant directly[2].
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We have developed a new three-dimensional printed 
polyethylene (3DP-PE) orbital implant since 2011[3]. A 
previous published study in animals did not find any infections 
or adverse systemic reactions[4]. In our previous study, we 
reported long-term outcome in terms of safety (infection and 
tissue reaction to the implant) and efficacy (exposure rate and 
grades of fibrovascular ingrowth into the implant) of the 3DP-
PE implant for both enucleation and evisceration in 21 patients 
which were followed up for at least 12mo. We have found that 
the 3DP-PE orbital implant is safe in terms of infection rate in 
the long-term follow-up[5].
Medpor (Stryker; Kalamazoo, MI) was the only commercial 
porous polyethylene orbital implant available in our country 
in 2011. Both Medpor and 3DP-PE are porous polyethylene 
orbital implants with different fabricating techniques. This 
study aims to compare between the 3DP-PE and Medpor in 
an equivalence trial. The primary objective of this study is to 
compare exposure rates in enucleation between both implants. 
The secondary objectives are to compare the infection rate, 
the percentage of fibrovascular ingrowth in the implants and 
the success rate. We hypothesized that the 3DP-PE orbital 
implant would achieve equivalent exposure rate, infection 
rate, percentage of fibrovascular ingrowth and the success rate 
compared to Medpor implant. 
SUBJECTS AND METHODS
Ethical Approval  We conducted a prospective, randomized, 
equivalence, controlled trial, patient and assessor blinded 
clinical trial at Department of Ophthalmology, Mettapracharak 
(Wat Rai Khing) Hospital and Department of Ophthalmology, 
Songklanagarind Hospital, Prince of Songkla University, 
Thailand. The study was approved by the Ethics Committee 
from both institutes (No.1/2554 and No.55-183-19-1-2 
respectively). The research adhered to the tenets of the 
Declaration of Helsinki and was registered at the clinical trials 
registry (Identifier, NCT01312545).
Subjects  We recruited patients between August 2012 and 
December 2020.
Inclusion criteria  The inclusion criteria were patients 
who were more than or equal to 18 years old, had good 
consciousness and could communicate. The causes of 
blindness were phthisis bulbi, painful blindness, intraocular 
tumor and severe ruptured eyeball.
Exclusion criteria  We excluded patients who had a history of 
prior enucleation or evisceration, recent eye infection within 
6mo and could not follow up for at least one year.
Methods  The allocation sequence was generated by a 
computerized program using block of six with varying block 
size with allocation concealment. Eligible patients scheduled 
for enucleation surgeries were allocated to have either Medpor 
or 3DP-PE implants and informed consent was obtained. The 

operations were performed by three oculoplastic surgeons 
from Mettapracharak (Wat Rai Khing) Hospital (Sintuwong 
S, Leelapatranurak K, and Lumyongsatien M) and two 
oculiplastic surgeons from Songklanagarind Hospital (Aryasit 
O and Preechawai P). All patients were followed up, each 
having at least four visits after surgeries (at 1wk, 1, 6 and 
12mo) with another oculoplastic surgeon (Nimitwongsakul 
O). The assessor and patients were masked to implant types. 
Data was collected, then validated and analyzed by staff at 
the Center of Excellence for Biomedical and Public Health 
Informatics (BIOPHICS). The primary outcome was the 
exposure rate and the secondary outcome was the infection 
rate, the percentage of fibrovascular ingrowth of both implants 
and the success rate. The vascularization of both implants was 
measured using the  magnetic resonance imaging (MRI) of the 
orbit and Image J software. 
Three-dimensional Printed Polyethylene Orbital 
Implant  The 3DP-PE implant (Figure 1) was prepared by a 
previously described technique[3,5-6]. In summary, high density 
polyethylene granules (Bangkok Polyethylene Co., Ltd, 
Thailand) were obtained and ground down to achieve a mean 
particle size of 305 mm. Maltodextrin (sourced from Shandong 
Duqing, Inc., China) and poly(vinyl alcohol) (sourced from 
Sigma-Aldrich, USA) having  particle size of 80-100 mm, 
were then mixed with polyethylene granules at the ratio of 
20%:10%:70% by weight. This mixture was loaded in a three-
dimensional printing machine (Z400, Z Corporation, USA) 
and 16, 18, 20, and 22 mm spheres were printed using the 
commercial water-based binder ZB7 (Z Corporation, USA). 
After fabrication, specimens were left in the printing machine 
for 2h, then removed and left in the atmosphere for 24h. The 
specimens were then air blown to remove any unbound powder 
and heat treated by using a wet salt bed technique[5-6]. In brief, 
the samples were heated at 145℃ for 1h, sonicated in water 
and heat treated again in a salt powder bed (using Prungtip 
salt, Thailand) at 145℃ for another 2h. All the samples were 
then cleaned in deionized water, dried and packed in a pouch 
before being sterilized by ethylene oxide gas. The 3DP-PE 

Figure 1 The three-dimensional printed polyethylene (3DP-PE) 

orbital implants (18 and 20 mm).

Local-made vs imported porous polyethylene orbital implant
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orbital implants had been studied for safety in pigs’ skull and 
no signs of infection were found after implantation for 20wk 
(Khongkhunthian P, unpublished data 2009) and no adverse 
systemic reactions were reported in a study using the implant 
as an onlay bone graft in the mandibles of 12 New Zealand 
white rabbits for 24wk[3]. Compared to the Medpor implant[2], 
the 3DP-PE scored well for suturing and shaping ability and 
also for antibiotic solution uptake.
Enucleation  After informed consent was obtained, patients 
were scheduled to have enucleation surgeries. Standard 
enucleations were performed under general anesthesia. Most 
surgeons sutured four recti muscles to the implants directly, 
some surgeons wrapped implants with autogenous donor sclera 
before suturing four recti muscles. Both types of implants 
were soaked and pores filled with gentamicin (40 mg/mL) 
solution by negative pressure technique before insertion[5]. In 
a case with a contracted socket, a buccal mucosal graft was 
harvested and placed between superior edge of the conjunctiva 
after enucleation. Fornix deepening sutures were used in some 
cases.
Definitions  Exposure was defined by the resolution of tissues 
over the anterior surface of an implant. Infection was defined 
by the presence of pus or abscess at or around an implant. It 
can be diagnosed clinically or confirmed by the histopathology 
report after the explantation. The success rate was defined as 
the percentage of participants without postoperative implant 
exposure. The time frame was within 12mo after the date of 
surgery.
Magnetic Resonance Imaging of the Orbit  To assess the 
degree of vascularization into the implant, some patients who 
agreed to benefits and risks of the MRI tests were sent to 
have MRI scans at least 6mo after surgery. A whole-body 1.5 
Tesla Siemens Symphony MRI model (Siemens, Erlangen, 
Germany) was used. T1-weighted (TE/TR=680/11) images 
were obtained in both institutes. The imaging sequences had 
an imaging matrix of 224×320 and a field of view of 160 mm. 
The slice thickness was 3 mm. Axial, coronal and sagittal 
enhanced T1-weighted images were obtained within 5min of 
Gadolinium injection. The central part of the implants and 
areas of fibrovascular ingrowth were marked on the axial 
image by one of the authors (Sintuwong S). The percentage 
of enhancement in the implants was measured by Image J 
software (NIH, Bethesda, MD, USA).
Percentage of Fibrovascular Ingrowth in the Implant by 
Measurement the Area of Enhancement Using Image J 
Software  Image J software for Windows was downloaded 
from https://imagej.nih.gov to a personal computer, and the 
MRI scan image file (Tag Image File Format; TIFF file) 
of the selected implant (the center of the implant in T1-
weighted with Gd with fat suppression) was opened from 

the File menu. To measure the area of enhancement, the author 
(Sintuwong S) used the thresholding process to highlight pixels 
in the image. This was done first by converting the image to 
grayscale (choosing image > type >8-bit). Then the Freehand 
selection tool was used to draw the outline of the implant. The 
Edit>Clear outside tool was used to clear the outer part of the 
outline. We then calculated the selected (total, X) area by using 
the Analyze>Measure command. The duplicate command 
(image>duplicate) was used to copy the area within the outline. 
By using the image>adjust>threshold tool, the pixels in one 
grayscale photo that represent vascularization turned red. We 
then adjusted by moving the scroll bars until the red areas were 
very similar to the areas of enhancement in another grayscale 
photo. We used the Rectangular selection tool, to limit the area 
of image analysis. In the Analyze >Set Measurement tool, we 
checked the “Area” and “Limit to Threshold” boxes to measure 
only the highlighted pixels within the selected rectangular area. 
The “Measure” analytical tool (Analyze>Measure) within the 
software was used to measure the area of highlighted pixels in 
the rectangular area (Y). The author (Sintuwong S) measured 
the area of enhancement of the implants three times and the 
average of these measurements was calculated. Lastly, the 
percentage of enhancement of the implant was calculated on 
the basis of dividing the average area of enhancement by the 
average total area of the implant (Y/X). 
Statistical Analysis  The sample size was calculated by 
using an equivalence formula. From the literature and our 
own experiences, the success rate for Medpor[7] and 3DP-PE 
were 92% and 94% respectively and the difference (D) of the 
success rate between two groups was 10%. The sample size 
with a ±10% equivalent margin should be 174 participants 
per arm. As a preliminary report, we enrolled about 50 
participants per group. Descriptive statistics were calculated 
using mean±standard deviation (SD), median (interquartile 
range; IQR) for continuous data and percentage for nominal 
data. A Chi-square test was used to compare the exposure 
rate, infection rate and success rate between two groups. The 
analysis adhered to the “intention to treat” and “per protocol” 
approaches. All statistical data analyses were performed by 
SPSS for Windows, version 28.0 (IBM, Armonk, NY, USA).
RESULTS
One hundred and forty-seven patients were enrolled in 
this study. Fifteen patients had history of surgeries before 
enrollments. Four patients declined to participate. Twenty-
three patients had follow-up time less than 12mo. Hence, 
105 patients (50 patients in Medpor group and 55 patients in 
3DP-PE group) completed the trial (Figure 2). The baseline 
characteristics of the participants were summarized in Table 1.
Outcome Measurement  Three patients (6.0%) in Medpor 
group and four patients (7.3%) in 3DP-PE group experienced 
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exposed implants (χ2=0.07; Table 2). Hence, the success 
rates of both groups were 94% and 92.7% respectively. No 
patient had infection in both groups. There was no statistically 
significant difference in exposure rate between Medpor and 
3DP-PE groups by the intention to treat and per protocol 
approaches, P<0.05, 95% confidence interval (CI; -9.8%, 
+12.0%). Also there was no statistically significant difference 
in success rate between both groups, P<0.05, 95%CI (-9.8%, 
+12.0%).
Other Complications  For the Medpor group, there was a 
postoperative orbital bleeding in one case (2.0%). The patient 
had further workup to identify the cause of bleeding. The 
final diagnosis was acquired factor VIII deficiency which was 
successfully treated by prescribing 2 units of fresh frozen 
plasma. One case (2.0%) had conjunctival papillary reactions 
and symptoms improved after applying anti-inflammatory and 
antibiotics eyedrops. Seven (14.0%) cases had postoperative 
ptosis and underwent ptosis surgeries later. For 3DP-PE 
group, two (3.6%) cases had conjunctival papillary reactions 
and symptoms improved after applying antibiotics and anti-
inflammatory eyedrops in one case and after stopping using 
antibiotic eye ointment in the other case. Four (7.3%) cases 
had postoperative ptosis and successfully underwent ptosis 
surgeries. No other serious adverse events were reported.
Percentages of Fibrovascular Ingrowth Using Image J 
Software  Four patients in Medpor group and five patients in 
3DP-PE group had MRI tests at least 6mo after operations. The 
percentages of enhancement were described in Table 3. The 
median percentage of enhancement in Medpor and 3DP-PE 
groups were 56.2 (IQR, 54.9-59.2) and 56.3 (IQR, 54.9-55.6) 
respectively. The MRI orbit (with Gadolinium enhancement) 
and Image J images of 3DP-PE and Medpor implants were 
shown in Figure 3.
DISCUSSION
The polyethylene orbital implant is one porous implant 
amongst many (hydroxyapatite, aluminium oxide, etc). 
It is widely used in many countries since it can promote 

vascularization into the implant and improves implant motility. 
It is considered superior to other porous implants as it is 
possible to suture directly to the implant without any wrapping 
materials[2]. The advantage of porous over non-porous orbital 

Figure 2 Flow diagram of study participants.

Table 1 Baseline demographic and clinical characteristics of the 

participants                                                                                 n (%)

Characteristics Medpor group 
(n=50)

3DP-PE group 
(n=55)

Age, y, mean (SD) 38.1 (12.6) 40.0 (16.5)
Sex

Male 28 (56.0) 26 (47.3)
Female 22 (44.0) 29 (52.7)

Race
Thai 50 (100.0) 53 (96.4)
Non-Thai 0 2 (3.6)

Causes of blindness
Congenital 11 (22.0) 12 (21.8)
Trauma 21 (42.0) 25 (45.5)
Infection 2 (4.0) 2 (3.6)
Glaucoma 4 (8.0) 8 (14.6)
Uveitis 1 (2.0) 1 (1.8)
Tumor 2 (4.0) 2 (3.6)
Other 0 1 (1.8)
Unknown 9 (18.0) 4 (7.3)

Visual acuity
NPL 41 (82.0) 52 (94.5)
PL 7 (14.0) 2 (3.7)
HM 2 (4.0) 1 (1.8)

Side
RE 26 (52.0) 23 (42.0)
LE 24 (48.0) 32 (58.0)

Implant number
22 10 (20.0) 5 (9.1)
20 27 (54.0) 33 (60.0)
19 0 1 (1.8)
18 13 (26.0) 13 (23.6)
16 0 3 (5.5)

Follow-up time, mo, mean (SD) 33 (23.1) 40 (29.3)

3DP-PE: Three-dimensional printed polyethylene; NPL: No perception 

of light; PL: Perception of light; HM: Hand motion; RE: Right eye; LE: 

Left eye.

Local-made vs imported porous polyethylene orbital implant
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implants for anophthalmic socket reconstruction was not 
concluded[8-9].
Medpor was the only commercial porous polyethylene orbital 
implant available in Thailand in 2011. Due to superiority of 
the porous polyethylene orbital implant, we have developed 
this type of implant with another fabricating technique. Our 
3DP-PE orbital implant was fabricated by a two-stepped 
heat technique, coupled with large-size polyethylene powder 
printing. By using a scanning electron microscope, the 3DP-
PE pore sizes ranged from 140 to 830 µm, the implants were 
lighter and had a greater and more rapid 1% methylene blue 
solution uptake compared to Medpor[3]. The pore size of 
Medpor ranged from 180 to 570 µm. The long-term safety 
(infection rate) and efficacy (exposure rate) in 21 patients who 
had 3DP-PE implantation after enucleation and evisceration 
was acceptable[5].
The demographic data between the two groups in this 
preliminary report were comparable. The most common cause 
of blindness was trauma, followed by congenital blindness, 
and glaucoma. Ababneh et al[10] reported that the four most 
common causes of eye removal in a developing country 
were trauma, endophthalmitis, glaucoma and keratitis which 
was similar to our results. However, we excluded cases with 
infection. Since the polyethylene orbital implant has an 

Figure 3 Images from MRI orbit and Image J software  The MRI orbit 
with Gadolinium enhancement of one patient at 6mo after 3DP-PE (A) 
implant surgery and an image from Image J software (C) of the same 
patient. The MRI orbit with Gadolinium enhancement  of another 
patient at 8mo after Medpor (B) implant surgery and an image from 
Image J software (D) of the same patient. 3DP-PE: Three-dimensional 
printed polyethylene; MRI: Magnetic resonance imaging.

Table 2 Patients with postoperative implant exposure
Patient No./
sex/side

Age 
(y) Diagnosis Implant size 

(mm)
Time between operation 

and implant exposure (mo)
Treatment of 

implant exposure
Follow- up time after 
last treatment (mo)

Medpor
99/F/LE 53 Painful blindness 20 63 DFG 12
100/M/LE 37 Metastatic choroidal mass 20 3 Suture 14
102/M/LE 37 Phthisis bulbi 20 3 DFG 4

3DP-PE

23/M/LE 32 Painful blindness 20 18 Exchange with 
3DP-PE no.20 37

36/M/LE 28 Painful blindness 18 14 Suture 12
93/M/LE 36 Blindness 20 49 DFG 8
101/M/RE 70 Painful blindness 20 13 DFG 24

3DP-PE: Three-dimensional printed polyethylene; M: Male; F: Female; RE: Right eye; LE: Left eye; DFG: Dermis fat graft.

Table 3 Percentage of enhancement in Medpor and 3DP-PE implants
Patient no./
sex/side

Age 
(y) Diagnosis Implant size 

(mm)
Time between 

operation and MRI (mo)
Follow-up time 

after surgery (mo)
Percentage of 
enhancement Note

Medpor
90/F/LE 48 Choroidal melanoma 18 7 36 53.0
91/F/RE 23 Painful blindness 18 25 16 55.5
94/M/LE 22 Blindness 20 7 33 56.9

99/F/LE 53 Painful blindness 20 19 75 66.3 Exposed implant 
at 63mo postop.

61/M/RE 44 Phthisis bulbi 20 7 17 61.0
89/F/LE 56 Phthisis bulbi 19 7 15 54.9

3DP-PE
92/F/RE 72 Choroidal melanoma 18 11 12 44.8

93/M/LE 36 Blindness 20 15 57 58.0 Exposed implant 
at 49mo postop.

95/F/LE 78 Choroidal melanoma 20 13 106 56.3
3DP-PE: Three-dimensional printed polyethylene; M: Male; F: Female; RE: Right eye; LE: Left eye; MRI: Magnetic resonance imaging.
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advantage compared to other porous implants that we can 
suture directly, we chose enucleation to compare between 
both implants in an equivalence trial. The most common 
complication of enucleation is the implant exposure[1,11] then 
we selected exposure as an outcome measurement. Some 
surgeons in our preliminary trial used the donor sclera to 
wrap the implants because they believed this can reduce the 
exposure rate and this might lead to bias in the study. The 
authors believe that the randomization method could prevent 
selection bias and both groups should not differ. Fourteen 
patients in the Medpor group and 9 patients in the 3DP-PE 
group had follow-up times of less than 12mo. Ten patients 
refused follow-up, citing reasons of lack of finance and lack of 
time. Others did not attend, and could not be contacted. 
Implant exposure is one of the most important complications 
after enucleation. It can lead to infection, poor fitting ocular 
prosthesis, additional surgery and increases cost of the 
treatment. The exposure rates between the groups were not 
found to be statistically different, 6.0% vs 7.3%, P<0.05, 
95%CI (-9.8%, +12.0%). Custer and Trinkaus[12] reviewed 
the exposure rate from 49 papers, they found exposure rates 
ranging from 0 to 34%. Yang et al[1] reported exposure rate in 
retinoblastoma cases, and reported a decrease from 56.8% to 
2.4% after changing some surgical techniques. An equivalence, 
randomized controlled trial was preferred to compare the novel 
implant (3DP-PE) with the reference implant (Medpor). A 
sample size calculation determined that 174 patients in each 
group would need to be recruited in the trial. This is very 
challenging for a long-term and high-cost study. A preliminary 
trial was therefore carried out. The exposure rate of Medpor 
implant was 6% and its success rate 94%. The exposure rate 
of the 3DP-PE implant was 7.3% and the success rate was 
92.7%, which was acceptable according to other studies[1,12-13]. 
There was a 95%CI on the difference between the exposure 
rates with a margin of -9.8% to +12.0% which was higher 
than the equivalent margin (±10%) that we had proposed. 
Consequently, we cannot interpret the 3DP-PE implant as 
having an equivalence to the Medpor implant in terms of the 
exposure rate. Further testing in an equivalence trial involving 
174 participants in each group is needed to compare the true 
exposure rates between the two groups.
Complications other than implant exposure included one 
patient (2%) who had massive orbital bleeding within a week 
after Medpor implantation. He was diagnosed with acquired 
factor VIII deficiency. His daughter had been diagnosed with 
factor VIII deficiency about one year prior to his diagnosis. 
Because of the natural history of the disease[14] and the 
patient’s family history, this complication was not related 
to the implant. One (2%) case in the Medpor group and one 
(1.8%) case in the 3DP-PE group had conjunctival papillary 

reactions which improved after applying anti-inflammatory 
and antibiotics eyedrops. Vollkommer et al[15] reported that the 
implantation of porous polyethylene as a facial reconstruction 
material may lead to chronic inflammation and foreign body 
giant cell reaction over a long period of time. It is possible 
that the conjunctival papillary reactions in both Medpor and 
3DP-PE groups could result from the implants. Another 3DP-
PE case (1.8%) with conjunctival papillary reaction improved 
after stopping antibiotic ointment use, indicated that the 
reaction might have resulted from the antibiotic ointment 
itself. Toribio et al[16] found that bacteria adhere more securely 
to porous polyethylene than to nonporous orbital implants, 
therefore an infected implant should be suspected if the patient 
has recurrent conjunctival inflammation with discharge. Seven 
(14%) cases in the Medpor group and four (7.3%) cases in 
the 3DP-PE group had postoperative ptosis. The causes of 
postoperative ptosis in these patients ranged from preoperative 
ptosis from the underlying disease and enophthalmos, to 
levator aponeurosis dehiscence caused by surgical techniques, 
which were supported by the reports from Custer et al[17] and 
Wang et al[18].
An MRI of the orbit was used to measure the fibrovascular 
ingrowth into the implant which was confirmed by the Image 
J software. Only 9 patients agreed to have MRI scans. The 
median percentage of enhancement of the two groups were 
56.2 (IQR, 54.9-59.2) and 56.3 (IQR, 54.9-55.6) which cannot 
be compared due to the very small sample size. Moreover, 
the time between the operations and MRI scans in each 
participant were different. Image J software is an objective 
method[19] used to measure enhancement in the implant 
referring to the fibrovascular ingrowth into the implant. The 
more enhancement, the more fibrovascular ingrowth in the 
implant. Image J software does not measure perfectly the area 
of enhancement. The precision of measurement depends on 
the resolution of the images and it was not possible for the 
researchers to control the enhancement scale to match the 
enhancement of the original image. Other than our previous 
report[5], have not found reports of using Image J software 
to calculate the enhancement in the implant. From the result 
(Table 3), we found two cases with implant exposure, despite 
having greater enhancement compared to patients with no 
implant exposure. These confirms that the percentage of 
fibrovascular ingrowth into the implant is not the only factor 
preventing implant exposure. Patients should have lifetime 
examinations after surgeries. 
Limitations of this study included, first many surgeons were 
involved in the study so we could not control possible bias 
from surgical factors. Second, the number of patients who had 
MRI tests were small because patients declined to have the 
tests, due to difficulty to travel, radiation hazard avoidance, etc. 

Local-made vs imported porous polyethylene orbital implant
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In summary, this is a preliminary study to compare between 
Medpor and 3DP-PE implants in enucleation. The infection 
rate was equivalent in both groups. Findings on the exposure 
rate were inconclusive.
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